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Der Java Client
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Der Java Client
Der Java Client stellt Ihnen innerhalb des IP-Netzwerks einen virtuellen Arbeitsplatz 
zur Verfügung. An diesem virtuellen Arbeitsplatz können Sie das KVM-Matrixsys-
tem bedienen und konfigurieren.

Die Software ist Bestandteil der Firmware des Gerätes und sofort nach der Installa-
tion des KVM-Matrixsystems betriebsbereit.

Systemvoraussetzungen
Der Java Client wird in der Laufzeitumgebung Java Runtime Environment (JRE) inner-
halb Ihres Webbrowsers ausgeführt.

Voraussetzung für den Start des Clients ist die Installation der Laufzeitumgebung in 
der Version 1.5.0 oder höher.

Die Laufzeitumgebung steht auf der Website http://java.sun.com/javase/downloads/ für 
die Betriebssysteme Windows, Solaris, Linux und Apple OS zum Download bereit.

Unterstützte Webbrowser

Folgende Webbrowser wurden erfolgreich mit dem Java Client getestet:

 Internet Explorer 7
 Internet Explorer 8
 Mozilla Firefox 3.6

Unterstützte Betriebssysteme

Folgende Betriebssysteme wurden erfolgreich mit dem Java Client getestet:

 Microsoft Windows XP
 Microsoft Windows Vista
 Microsoft Windows 7
 GNU/Linux Ubuntu 10.04
 GNU/Linux Ubuntu 10.10

WICHTIG: Die Open-Source-Implementation OpenJDK der Java-Plattform wird 
nicht unterstützt.



Erste Schritte
Erste Schritte
Die grundlegende Bedienung des Java Clients lernen Sie in diesem Kapitel kennen.

Start des Java Clients
Der Java Client kann über einen unterstützten Webbrowser eines Computers mit 
installierter Laufzeitumgebung Java Runtime Environment gestartet werden.

So starten Sie den Java Client:

1. Geben Sie in der Adresszeile die URL https://[IP-Adresse des Gerätes] zum Aufruf 
der Webapplikation ein.

2. Falls das im KVM-System gespeicherte Zertifikat nicht verifiziert werden kann, 
werden Sie zur Authentisierung des Zertifikates aufgefordert. Das standardmä-
ßig hinterlegte Zertifikat erkennen Sie an folgenden Merkmalen:

3. Klicken Sie oberhalb der Eingabefelder der Login-Maske auf Client starten.

HINWEIS: Detaillierte Erläuterungen der Funktionen und Einstellungen erfolgen 
in den folgenden Kapiteln dieses Handbuchs.

HINWEIS: Informationen zu den Systemvoraussetzungen des Clients finden Sie 
auf Seite 1.

HINWEIS: Wird die Webapplikation über eine „normale“ http-Verbindung 
gestartet, erhalten Sie den Hinweis, dass der Verbindungsaufbau ausschließlich 
über eine sichere https-Verbindung möglich ist.

Nach 10 Sekunden erfolgt automatisch die Weiterleitung auf die sichere https-
Verbindung.

MD5-Fingerabruck:

A4:53:5C:42:E4:7C:B8:C7:74:1E:40:3F:D7:FE:95:99

SHA1-Fingerabdruck

E1:59:BF:BC:E3:53:B1:56:0E:23:CE:0E:ED:49:56:CF:98:78:DC:87
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Erste Schritte
Eine Verbindung zum KVM-Matrixsystem herstellen
Nach dem Start der Software können Sie eine Sitzung mit dem KVM-Matrixsystem 
starten. Hiernach wird innerhalb des Java Clients der virtuelle Arbeitsplatz darge-
stellt.

Eine Sitzung mit dem KVM-Matrixsystem starten

So starten Sie eine Sitzung mit dem KVM-Matrixsystem:

1. Geben Sie im Abschnitt Authentifizierung den Benutzernamen und das Kennwort Ihres 
Benutzerkontos ein.

2. Wählen Sie im Abschnitt Language/Sprache die von Ihnen gewünschte Sprache 
(Deutsch oder English) der Software.

3. Wählen Sie im Abschnitt Keyboard Layout/Tastatur Layout die Sprachvariante der 
Tastatur (Deutsch, American English, British English, French oder Belgian) Ihres Arbeits-
platzes aus.

4. Optional: Klicken Sie auf Optionen, falls Sie die (s. Seite 26 ff.) Sitzungsein-
stellungen konfigurieren möchten.

5. Starten Sie den Verbindungsaufbau (s. Seite 9) durch Klick auf Anmelden.

WICHTIG: Falls Ihnen die Zugangsdaten nicht vorliegen, erfragen Sie diese 
beim Administrator des Matrixsystems.
G&D UCON-IP-NEO · 3



Erste Schritte
Das Client-Fenster
Nachdem der Java Client eine Verbindung zum KVM-Matrixsystem aufgebaut hat, 
erscheint auf Ihrem Bildschirm das Client-Fenster:

In diesem Fenster wird das On-Screen-Display des KVM-Matrixsystems bzw. die 
Bildschirmausgabe des aufgeschalteten Zielrechners dargestellt.

Informationen der Titelzeile

In der Titelzeile des Client-Fensters werden neben dem Namen der Software 
folgende Informationen angezeigt:

HINWEIS: Da die Darstellung des On-Screen-Displays nicht vom KVM-Matrixsys-
tem, sondern durch den Java Client erstellt wird, ist die Änderung der Positio-
nierung und die Synchronisationseinstellung nicht möglich!

Bedienungsstatus: Ist die Bedienung des Zielrechners innerhalb des Client-
Fensters aktiv, wird in der eckigen Klammer Bedienung aktiv
angezeigt.

Andernfalls wird in der eckigen Klammer Bedienung inaktiv
angezeigt.

IP-Adresse des 
Gerätes:

Die IP-Adresse des KVM-Matrixsystems auf welchem die Sit-
zung gestartet wurde, wird zur Ihrer Information angezeigt.

Name des
Zielrechners:

Im Abschnitt Zielrechner wird der Name des aufgeschalteten 
Zielrechners angezeigt.
4 · G&D UCON-IP-NEO



Erste Schritte
Informationen der Statuszeile

In der Statuszeile werden folgende Informationen (von links nach rechts) angezeigt:

Belegungssymbol: Das Symbol zeigt an, ob ein oder mehrere Benutzer auf den 
Zielrechner zugreifen.

Name des
Zielrechners:

Name des aufgeschalteten Zielrechners des Matrixsystems

Bezeichnung des
Videoprofils:

Bezeichnung des Videoprofils, welches dem aufgeschalteten 
Zielrechner zugeordnet wurde

Datentransferrate: Datentransferrate (in Kilobyte pro Sekunde) zwischen dem 
Matrixsystem und dem Java Client.

Bildfrequenz: Anzahl der Bildaktualisierungen pro Sekunde die im Client-
Fenster dargestellt werden

»Num Lock«-LED Die LED wird hellgrün dargestellt, wenn die Num-Lock-
Funktion auf dem Zielrechner aktiv ist.

Ist die Funktion nicht aktiv, wird die LED dunkelgrün dar-
gestellt.

»Caps Lock«-LED Die LED wird hellgrün dargestellt, wenn die Feststelltaste auf 
dem Zielrechner betätigt wurde.

Ist die Feststelltaste nicht aktiv, wird die LED dunkelgrün 
dargestellt.

»Scroll Lock«-LED Die LED wird hellgrün dargestellt, wenn die Scroll-Lock-
Funktion auf dem Zielrechner aktiv ist.

Ist die Funktion nicht aktiv, wird die LED dunkelgrün dar-
gestellt.

HINWEIS: Die Statuszeile kann wahlweise oben oder unten innerhalb des Client-
Fensters angezeigt werden (s. Seite 16).
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Erste Schritte
Auslösen der Maus aus dem Client-Fenster

Ist die Bedienung des On-Screen-Displays des Matrixsystems bzw. des Zielrechners 
innerhalb des Client-Fensters aktiv, wird in der eckigen Klammer Bedienung aktiv
angezeigt.

Die Bedienung des lokalen Computers mit den Eingabegeräten ist erst nach Auslö-
sen der Maus aus dem Client-Fenster möglich.

So lösen Sie die Maus aus dem Client-Fenster aus:

 Drücken und halten Sie die Tasten Strg+Shift während Sie zusätzlich die 
linke Maustaste betätigen.

Verschieben des Fensterausschnittes (Scrollen)

Ist die Bildschirmauflösung des Zielrechners größer als jene Ihres Computers, so 
kann nur ein Ausschnitt des Bildschirminhaltes des Zielrechners auf Ihrem Monitor 
angezeigt werden.

Über die Bildlaufleisten des Client-Fensters oder mit den Schaltflächen im Scrollen-
Bereich des Steuerboards können Sie den darzustellenden Ausschnitt auswählen.

So wählen Sie den darzustellenden Ausschnitt mit der Maus:

 Klicken Sie auf die Bildlaufleisten des Client-Fensters zur Auswahl des darzu-
stellenden Ausschnitts.

 Klicken Sie auf die Schaltflächen (s. u.) im Scrollen-Bereich des Steuerboards.

So wählen Sie den darzustellenden Ausschnitt mit der Tastatur:

1. Stellen Sie sicher, dass das Client-Fenster aktiv und die »Num  Lock«-Funktion 
ausgeschaltet ist.

2. Halten Sie Strg+Shift gedrückt, während Sie eine der 
rechts abgebildeten Navigationstasten (Num-Taste) des 
numerischen Tastenblocks betätigen:

 Die Tasten 8 (hoch), 6 (rechts), 2 (runter) und 4 (links) 
bewegen den Bildausschnit in kleinen Schritten.

 Die Tasten 9 (rechts oben), 3 (rechts unten), 1 (links 
unten) und 7 (links oben) positionieren den Bildaus-
schnitt an die entsprechenden Positionen.

 Die Tasten 5 zentriert den Bildausschnitt in der Mitte.

HINWEIS: In diesem Status werden die Tastatureingaben und Mausaktionen am 
lokalen Computer direkt an den Zielrechner weitergeleitet.
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Erste Schritte
Umschalten zwischen den Zielrechnern
Zwischen den am KVM-Matrixsystem angeschlossenen Zielrechnern können Sie 
wahlweise über das On-Screen-Display oder über das Steuerboard umschalten.

Nähere Erläuterungen zu den jeweiligen Verfahren erhalten Sie in den folgenden 
Abschnitten.

Umschaltung über das Steuerboard

So schalten Sie einen Zielrechner über das Steuerboard auf:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Zielrechner.

3. Verwenden Sie ggf. die Filterfunktion (s. Seite 12), um die Auflistung der Ziel-
rechner einzugrenzen.

4. Wählen Sie mit der Maus oder den Pfeiltasten der Tastatureinen  Zielrechner aus.

5. Führen Sie einen Doppelklick aus oder betätigen Sie die Eingabetaste.

Umschaltung über das On-Screen-Display (OSD)

So schalten Sie einen Zielrechner über das On-Screen-Display auf:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie auf die Schaltfläche AdonIS.

3. Wählen Sie den aufzuschaltenden Zielrechner mit den Pfeiltasten aus.

4. Betätigen Sie die Eingabetaste.

Wechsel zwischen Zielrechner und lokalem 
Computer
Möchten Sie während einer Sitzung auf einem Zielrechner, Tastatur und/oder 
Mausaktionen auf Ihrem lokalen Computer durchführen, ist dies ohne Beendigung 
der Sitzung oder Aufruf des Steuerboards möglich.

Detaillierte Informationen zu diesem Thema finden Sie im Abschnitt Auslösen der 
Maus aus dem Client-Fenster auf Seite 6.

TIPP: Klicken Sie im Steuerboard auf die Schaltfläche Last Target (s. Seite 13), um 
sich auf den zuletzt aktiven Zielrechner aufzuschalten.
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Erste Schritte
Timeout bei Inaktivität
Haben Sie während einer aktiven Sitzung innerhalb von 10 Minuten (Standardein-
stellung) keine Tastatur- bzw. Mausaktion durchgeführt, wird die Beendigung der 
aktiven Sitzung eingeleitet.

Ein Informationsfenster informiert Sie nach Ablauf des Timeouts über die bevor-
stehende Beendigung der Sitzung und bietet Ihnen folgende Wahlmöglichkeiten:

 Sitzung beenden: Klicken Sie auf diese Schaltfläche, um die aktive Sitzung sofort zu 
beenden.

 Fortsetzen: Klicken Sie auf diese Schaltfläche, um die aktuelle Sitzung fortzusetzen.

Einsatz von Hotkeys während einer Sitzung
Innerhalb eines aktivierten Client-Fensters stehen Ihnen die folgenden Hotkeys 
während einer Sitzung zur Verfügung.

Beenden der aktiven Sitzung
Zum Beenden der aktiven Sitzung haben Sie zwei Möglichkeiten: Sie können die 
Sitzung über das Menü des Steuerboards oder durch das Schließen des Client-Fens-
ters beenden

So beenden Sie die aktive Sitzung:

 Ist das Steuerboard geöffnet, klicken Sie in diesem auf das Menü Aktion > Sitzung 
schließen.

 Andernfalls schließen Sie das Client-Fenster durch einen Klick auf das Schließen-
Symbol des Fensters.

Beenden der Software

So beenden Sie die Ausführung der Software auf Ihrem Computer:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Aktion > Beenden.

TIPP: Über die Webapplikation Config Panel können Sie die Einstellung des Timeouts 
ändern. Die entsprechende Einstellung finden Sie auf dem Reiter KVM-Server der 
Konfigurationseinstellungen des Matrixswitches.

Strg+Shift+Maustaste Auslösen der Maus aus dem aktiven Client-Fenster

Strg+Shift+Num-Taste In Kombination mit dem Ziffernblock der Tastatur, 
können Sie innerhalb des Client-Fensters navigieren.
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Verbindungsaufbau
Verbindungsaufbau
Während des Verbindungsaufbaus einer Sitzung erscheint auf Ihrem Bildschirm ein 
Fenster, welches Sie über den aktuellen Status des Verbindungsaufbaus informiert:

In diesem Fenster werden (von oben nach unten) folgende Informationen angezeigt:

 Fortschrittsbalken: Hier können Sie den aktuellen Fortschritt des Anmeldevorgangs 
erkennen. Die aktuell durchgeführte Aktion wird über dem Balken angezeigt.

 Kanal-Verschlüsselung: Die verschiedenen Kanäle und die angewendeten Ver-
schlüsselungen (s. Seite 27) werden angezeigt.

Messung der Bandbreite
Während des Verbindungsaufbaus wird eine Bandbreitenmessung durchgeführt.

Der ermittelte Wert der Messung wird anschließend im Rahmen der Aufbereitung 
und Übertragung der Videoinformationen angewendet.

TIPP: Klicken Sie während der Bandbreitenmessung auf Erweitert, um eine grafische 
Darstellung der aktuellen gemessenen Bandbreite in Form einer Kurve anzuzeigen.

HINWEIS: Die zur Verfügung stehende Bandbreite innerhalb eines IP-Netzwerkes 
kann sich – je nach Auslastung des Netzwerkes – ändern. Dies kann zu einem 
Performanceverlust führen.

Führen Sie ggf. eine erneute Bandbreitenmessung (s. Seite 28) während der Sit-
zung durch, falls Sie einen Performanceverlust feststellen.
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Verbindungsaufbau
Chat-Funktion
Der Java Client kann auf mehreren Computern innerhalb des IP-Netzwerkes 
installiert werden.

Die Chat-Funktion des Clients ermöglicht dem Benutzer, der sich am System 
anmeldet, mit einem bereits angemeldeten Benutzer in Kontakt zu treten.

Beide Benutzer können innerhalb des Chats die weitere Vorgehensweise abstimmen.

So stimmen Sie die weitere Vorgehensweise bei bereits belegter Konsole inner-
halb eines Chats ab:

1. Starten Sie den Verbindungsaufbau (s. Seite 3).

2. Klicken Sie im Fenster auf Ja, um das Chat-Fenster zu öffnen.

3. Das Chat-Fenster wird auf Ihrem und dem Bildschirm des anderen Benutzers 
angezeigt.

4. Geben Sie Ihre Nachricht in das Eingabefeld ein und klicken Sie auf Senden oder 
betätigen Sie die Eingabetaste, um Ihre Nachricht an den anderen Benutzer zu 
versenden.

5. Die Anwort des anderen Benutzers wird im Textfeld im oberen Bereich des Fens-
ters angezeigt. Hierauf können Sie erneut, wie in Schritt 4. erläutert, antworten.

Die Chat-Kommunikation wird beendet, wenn der andere Benutzer Ihren Ver-
bindungswunsch ablehnt bzw. zustimmt oder Sie den Anmeldevorgang durch Klick 
auf Sitzung beenden abbrechen.

HINWEIS: Zur gleichen Zeit kann immer nur ein Benutzer auf einen IP-Arbeits-
platz des Systems zugreifen.

HINWEIS: Auf Ihrem Bildschirm erscheint ein Hinweis-Fenster, das über die 
Belegung der des IP-Arbeitsplatzes informiert und eine Verbindungsaufnahme 
mit dem anderen Benutzer anbietet.

WICHTIG: Wird innerhalb des Zeitfensters von 10 Sekunden keine Schaltfläche 
angeklickt, wird der Verbindungsaufbau automatisch abgebrochen.

HINWEIS: Wird der Verbindungsaufbau durch Klick auf Nein abgebrochen, 
wird wieder das Anmeldung-Fenster angezeigt.

HINWEIS: Gibt der andere Benutzer nicht innerhalb von 45 Sekunden eine 
Nachricht in das Textfenster ein oder klickt auf Ablehnen oder Sitzung beenden
wird seine Sitzung automatisch beendet und Ihre Sitzung hergestellt.
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Das Steuerboard
Das Steuerboard

Das Steuerboard ist die Bedienzentrale des Java Clients. Alle wichtigen Pro-
grammfunktionen sind über das Steuerboard erreichbar:

 Umschaltung zwischen den verfügbaren Zielrechnern
 Aufruf des On-Screen-Displays des Matrixsystems
 Ausführung von Tastatur-Makros
 Scrollen des sichtbaren Bildschirminhalts im Client-Fenster der Software
 Auswahl des darzustellenden Bildschirm-Ausschnittes des Zielrechners

Die Benutzeroberfläche
Auf der Benutzeroberfläche stehen Ihnen die nachfolgend aufgeführten Status-
Anzeigen und Werkzeuge zur Verfügung.

Status-Anzeige der Link-Verbindung

Im Feld Link Status wird der aktuelle Status der seriellen Verbindung 
zwischen dem Java Client und dem KVM-Matrixsystem angezeigt.

HINWEIS: Über die Link-Verbindung werden die im On-Screen-Display darzu-
stellenden Informationen und die Schaltzustände der Zielrechner an die Software 
übermittelt.
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Das Steuerboard
Menüleiste

Die Menüleiste zeigt die aktuell verfügbaren Befehle an (Aktion, Zielrechner oder 
Makros, Video, System, Ansicht, Hilfe).

Filterfunktion

Mit der Filterfunktion oberhalb der Auflistung der Zielrechner können Sie die 
Anzeige der Zielrechner eingrenzen.

So grenzen Sie die Auflistung der Zielrechner mit der Filterfunktion ein:

1. Geben Sie im Textfeld eine beliebige Zeichenkette ein.

2. Auf dem Karteireiter Zielrechner werden daraufhin ausschließlich solche Rechner 
angezeigt, die die eingegebene Zeichenkette in der Spalte Zielrechner, Physikalische 
Adresse oder Kommentar enthalten.

Die Groß-/Kleinschreibung der Namen wird bei der Filterung ignoriert.

3. Um die Filterung aufzuheben, klicken Sie auf Löschen.

Link-Verbindung korrekt hergestellt.

Link-Verbindung gestört.

HINWEIS: Abhängig von der aktivierten Karteikarte des Steuerboards wird entwe-
der der Menüeintrag Zielrechner oder Makro angezeigt.
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Das Steuerboard
Aufschaltung auf den zuletzt aktiven Zielrechner (Last Target)

Mit der Last Target-Funktion schalten Sie vom derzeit aktiven Zielrechner auf 
den zuletzt aufgeschalteten Zielrechner um.

So schalten Sie die Verbindung auf den zuletzt aufgeschalteten Zielrechner um:

1. Klicken Sie auf das Last Target-Symbol neben dem Filterfeld.

Verschieben des Fensterausschnittes (Scrollen)

Ist die Bildschirmauflösung des Zielrechners größer als jene Ihres Computers, so 
kann nur ein Ausschnitt des Bildschirminhaltes des Zielrechners auf Ihrem Monitor 
angezeigt werden.

Über die Schaltflächen im Scrollen-Bereich des Steuerboards können Sie den darzu-
stellenden Ausschnitt auswählen. Weiterführende Informationen finden Sie im 
Abschnitt Verschieben des Fensterausschnittes (Scrollen) auf Seite 6.

Informationen der Statuszeile

In der Statuszeile werden folgende Informationen (von links nach rechts) angezeigt:

Karteikarten des Steuerboards

Den größten Teil des Steuerboards nehmen die Karteikarten in der Mitte des Fensters 
ein. Hier können Sie wahlweise die Karteikarten Zielrechner oder Makros anzeigen:

 Die Karteikarte Zielrechner enthält eine Auflistung der angeschlossenen Zielrechner.
Zu jedem Zielrechner werden folgende Informationen angezeigt:

HINWEIS: Wurde seit dem Start des Java Clients noch kein Zielrechner aufgeschal-
tet oder ausschließlich auf dem aktuell aufgeschalteten Zielrechner gearbeitet, 
steht diese Funktion nicht zur Verfügung.

Bezeichnung des
Videoprofils:

Bezeichnung des Videoprofils, welches dem aufgeschalteten 
Zielrechner zugeordnet wurde

Datentransferrate: Datentransferrate (in Kilobyte pro Sekunde) zwischen dem 
Matrixsystem und dem Java Client

Bildfrequenz: Anzahl der Bildaktualisierungen pro Sekunde die im Client-
Fenster dargestellt werden
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Das Steuerboard
Die Symbole vor den Bezeichnungen der Zielrechner haben folgende Bedeutung:

 Die Karteikarte Makros ermöglicht das Ausführen von Tastaturmakros (s. Seite 22).

Darstellungsoptionen der Einträge der Karteikarten

Die Auflistung der Zielrechner bzw. Makros der Karteikarten können in folgenden 
Anzeigemodi betrachtet werden:

 Liste: Anzeige kleiner Symbole und Angabe des Namens (nebeneinander)
 Details: Anzeige kleiner Symbole, Angabe des Namens sowie weiterer Informa-

tionen in Tabellenform

So ändern Sie den Anzeigemodi zur Darstellung der Zielrechner bzw. Makros:

1. Öffnen Sie ggf. das Steuerboard der Software.

2. Öffnen Sie das Ansicht-Menü.

3. Wählen Sie den Eintrag Liste oder Details des Menüs.

Zielrechner: Bezeichnung des Zielrechners im Matrixsystem

Phys. Adr.: physikalische Adresse des Zielrechners

Status: Schaltzustand (An oder Aus) des Zielrechners

Zugriff: Zugriffsberechtigung auf den Zielrechner

Kommentar: vom Anwender erfasster Zielrechner-Kommentar

Sie sind auf diesen Zielrechner aufgeschaltet.

Ein anderer Benutzer ist auf diesen Zielrechner aufgeschaltet.

Mehrere Benutzer sind auf diesen Zielrechner aufgeschaltet.

Der Zielrechner ist eingeschaltet ist (grüner Punkt).

Der Zielrechner ist ausgeschaltet (roter Punkt).

TIPP: Die anzuzeigenden Tastaturmakros können Sie durch die Auswahl einer 
Gruppe (s. Seite 22) filtern.
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Das Steuerboard
Anzeige des On-Screen-Displays über das Steuerboard

Das On-Screen-Display (OSD) des KVM-Matrixsystems kann 
jederzeit im Client-Fenster angezeigt werden. Über das OSD ist die 
Bedienung und Konfiguration des Systems möglich.

So zeigen Sie das On-Screen-Displays des Matrixsystems im Client-Fenster an:

1. Klicken Sie auf die Schaltfläche AdonIS.

Durchführbare Aktionen im Steuerboard

Steuerboard schließen

Schließen Sie das Steuerboard, um die Arbeit im Client-Fenster der Software fortzu-
setzen.

So schließen Sie das Steuerboard:

1. Klicken Sie im Menü auf Aktion > Steuerboard schließen.

Sitzung schließen

Beenden Sie die Sitzung mit dem KVM-Matrixsystem nach Abschluss Ihrer Arbeiten 
oder um beispielsweise einem anderen Benutzer die Verwendung des IP-Arbeitsplatz-
platzes zu ermöglichen.

So schließen Sie die Sitzung:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Aktion > Sitzung schließen.

Software beenden

So beenden Sie die Ausführung der Software auf Ihrem Computer:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Aktion > Beenden.

HINWEIS: Da die Darstellung des On-Screen-Displays nicht vom KVM-Matrix-
system, sondern vom Java Client erstellt wird, ist die Änderung der Positionierung 
und die Synchronisationseinstellung nicht möglich!

TIPP: Während Ihrer Arbeit auf einem Zielrechner innerhalb des Client-Fensters 
können Sie das OSD durch Verwendung der Tastenkombination Strg+Num
(Standard) des Matrixsystems aufrufen.
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Das Steuerboard
Umschaltung auf Vollbild-Modus des Client-Fensters

Ist auf dem Zielrechner und auf Ihrem lokalen Computer die gleiche Bildschirmauf-
lösung eingestellt, empfiehlt sich die Darstellung des Client-Fensters im Vollbild-
Modus.

In diesem Modus wird das Client-Fenster auf die vollständige Desktopgröße erwei-
tert, damit der komplette Bildschirm für das Bild des Zielrechners zur Verfügung 
steht.

So schalten Sie das Client-Fenster in den Vollbild-Modus:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Video > Vollbild oder betätigen Sie die F11-Taste.

Position der Statuszeile festlegen

Die Statuszeile des Client-Fensters kann wahlweise am oberen (Standard) oder am 
unteren Fensterrand angezeigt werden.

So bestimmen Sie die Position der Statuszeile des Client-Fenster:

1. Öffnen Sie ggf. das Steuerboard der Software.

2. Klicken Sie im Menü auf Ansicht > Statuszeile > Oberer Fensterrand oder alternativ 
Ansicht > Statuszeile > Unterer Fensterrand.

HINWEIS: Taskleisten und andere Bedienelemente auf Ihrem Desktop werden 
durch den Vollbild-Modus des Client-Fensters überdeckt.

Im Vollbild-Modus ist das Scrollen innerhalb des Client-Fensters nicht erforderlich.
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Videoeinstellungen
Videoeinstellungen
Beim ersten Aufschalten auf einen Zielrechner wird ein Videoprofil für diesen 
Rechner erstellt und gespeichert.

Jedes Videoprofil hat eine individuelle Bezeichnung. Der Grundaufbau der von der 
Software erstellten und vom Benutzer editierbaren Bezeichnungen hat folgende Syntax:

 [Bildpunkte_horizontal]×[Bildpunkte_vertikal]@[Wiederholfrequenz_vertikal]

Anzeige der Detailinformationen

So rufen Sie die Einstellungen des aktuellen Videoprofils auf:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüleiste auf Video > Videoeinstellungen > Aktuelles Profil bear-
beiten.

Änderung eines Videoprofils
Alle Daten des Videoprofils (Bildlage, die Phasenverschiebung und die Farbwerte) 
können durch den Benutzer editiert und angepasst werden.

So ändern Sie die Einstellungen des aktuellen Videoprofils:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüleiste auf Video > Videoeinstellungen > Aktuelles Profil bear-
beiten.

3. Ändern Sie die gewünschte(n) Einstellung(en) des Videoprofils (s. Seite 18 f.).

4. Klicken Sie auf Speichern, um die Einstellungen zu speichern oder verwerfen Sie 
Ihre Eingaben durch Klick auf Abbrechen.

HINWEIS: Videoprofilen, die im Rahmen der ersten Aufschaltung auf einen Ziel-
rechner – ohne Ermittlung der Farbwerte – erstellt wurden, wird die Zeichenfolge 
Auto- vorangestellt.

Wurde ein Videoprofil im Rahmen des Erstinbetriebnahmemodus der Software IP-
Console Client bzw. mit der Funktion Videoprofil erstellen erstellt, wird diesem die 
Zeichenfolge EIM- vorangestellt.
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Videoeinstellungen
Einstellungsoptionen
Die Videoeinstellungen des Profils können vom Benutzer editiert werden. Auf den 
folgenden Seiten werden die möglichen Einstellungen der verschiedenen Karteikarten
des Fensters erläutert.

Der untere Bereich des Fensters ist auf allen Karteikarten identisch:

Links unten wird die die Datentransferrate (in Kilobyte pro Sekunde) zwischen dem 
KVM-Matrixsystem und dem Java Client sowie die Anzahl der Bildaktualisierungen 
pro Sekunde im Client-Fenster (Bildfrequenz) angezeigt.

Zusätzlich finden Sie hier folgende Bedienelemente:

Bestimmen von Bildbreite, -lage und -größe

Auf der Karteikarte Bild haben Sie die Möglichkeit, die Bildbreite, -lage und -größe 
festzulegen.

direkt anzeigen: Änderungen an den Einstellungen werden sofort auf die Bildan-
zeige im Client-Fenster angewendet

Testen: Änderungen an den Einstellungen auf die Bildanzeige im Client-
Fenster anwenden

Neu zeichnen: Synchronisierung des übertragenen Bildes des Zielrechners

Abbrechen: Änderungen an den Einstellungen verwerfen und Dialog schließen

Schließen: Temporäre Speicherung der Einstellungen bis zum erneuten 
Aufschalten des Zielrechners

Speichern: Speicherung der Einstellungen

Rückgängig: Änderungen seit dem letzten Speichern verwerfen

TIPP: Möchten Sie die auf dieser Karteikarte editierbaren Einstellungen automa-
tisch ermitteln lassen, klicken Sie auf Bildlageerkennung.

Folgende Voraussetzungen sind zur verlässlichen Ausführung der Funktion 
erforderlich:

 Die Bildschirmauflösung des Zielrechners ist kleiner als jene des Client-Fensters.
 Die Einstellung der Ränder des aktuell aufgeschalteten Zielrechners liegen inner-

halb einer errechneten Größe (abhängig von der jeweiligen Bildauflösung).
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Videoeinstellungen
Folgende Einstellungen können von Ihnen individuell optimiert werden:

So ändern Sie die vorbelegten Werte:

1. Ändern Sie die gewünschten Werte in den verschiedenen Eingabefeldern.

Hierbei ist es empfehlenswert, die numerischen Werte nicht direkt über die 
Tastatur einzugeben, sondern die Pfeiltasten zu verwenden.

Bildbreite: Breite des Bildes (inkl. der Schwarzschulter) in Pixel

Die Bildbreite ist immer größer als die Breite des tatsächlich sichtbaren 
Bildbereiches!

Vertikale
Bildlage:

Pixel (vertikal) ab welchem das Bild beginnt

Vertikale
Bildgröße:

Höhe des sichtbaren Bildbereiches

Bei der Einstellung der Bildhöhe können Sie sich an den üblichen Bild-
schirmauflösungen orientieren (z. B. 1024 × 768).

Stellen Sie die Bildhöhe so ein, dass oben kein schwarzer Rand verbleibt 
und das Bild vollständig sichtbar ist.

Horizontale
Bildlage:

Pixel (horizontal) ab welchem das Bild beginnt

Horizontale
Bildgröße:

Breite des sichtbaren Bildbereiches

Bei der Einstellung der Bildbreite können Sie sich an den üblichen Bild-
schirmauflösungen orientieren (z. B. 1024 × 768).

Stellen Sie die Bildlage so ein, dass links kein schwarzer Rand verbleibt 
und das Bild vollständig sichtbar ist.

TIPP: Haben Sie die Funktion direkt anzeigen (s. Seite 18) aktiviert, können Sie 
die Einstellungen komfortabel ändern und gleichzeitig die Auswirkung im 
Client-Fenster betrachten.

HINWEIS: Klicken Sie auf Rückgängig, um die ursprünglichen Werte dieses Rei-
ters wieder zu aktivieren. 
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Videoeinstellungen
Bestimmen der Farbwerte

Auf der Karteikarte Farben können Sie die Farbwerte und die Helligkeit des Bildes 
individuell einstellen.

Folgende Einstellungen können von Ihnen individuell optimiert werden:

So ändern Sie die vorbelegten Werte:

1. Verwenden Sie die Schieberegler, um die Farbwerte und die Helligkeit einzustellen.

Alternativ können Sie die gewünschten Werte direkt in den entsprechenden 
Eingabefeldern erfassen.

TIPP: Möchten Sie die auf dieser Karteikarte editierbaren Einstellungen automa-
tisch ermitteln lassen, klicken Sie auf Auto-Farbeinstellung.

Rot: Einstellung des Farbwertes der Farbe rot

Grün: Einstellung des Farbwertes der Farbe grün

Blau: Einstellung des Farbwertes der Farbe blau

Farbregler
synchronisieren:

Aktivieren Sie diese Option, wenn Sie den Kontrast anpassen 
möchten. Bei der Änderung eines Farbwertes werden die 
Werte der beiden anderen Farben ebenfalls angepasst.

Ist die Funktion deaktiviert (Standard) können Sie die Gewich-
tung der einzelnen Farben verändern, beispielsweise um einen 
Farbstich im Bild zu korrigieren.

Helligkeit: Einstellung der Grundhelligkeit des Bildes

TIPP: Haben Sie die Funktion direkt anzeigen (s. Seite 18) aktiviert, können Sie 
die Einstellungen komfortabel ändern und gleichzeitig die Auswirkung im 
Client-Fenster betrachten.

HINWEIS: Klicken Sie auf Rückgängig, um die ursprünglichen Werte dieses Rei-
ters wieder zu aktivieren. 
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Videoeinstellungen
Einstellung der Phasenlage

Die Einstellung der Phasenlage ist eine wesentliche Einstellung für die korrekte Ver-
arbeitung des Videosignals.

So ändern Sie die vorbelegte Phaseneinstellung:

1. Wählen Sie im Abschnitt Einstellung die Option manuell.

2. Stellen Sie den gewünschten Wert ein.

Hierbei ist es empfehlenswert, die numerischen Werte nicht direkt über die 
Tastatur einzugeben, sondern die Pfeiltasten zu verwenden.

3. Optional: Aktivieren Sie falls gewünscht die Option Rauschunterdrückung.

TIPP: Die Funktion Autophase übernimmt die Phaseneinstellung für den Benutzer.

Zur korrekten Ausführung der Funktion ist die Ausgabe eines statischen Bildes 
(beispielsweise des Desktops) durch den Zielrechner erforderlich.

Ist auf dem Zielrechner ein Bildschirmschoner aktiv, kann die Funktion nicht 
durchgeführt werden!

TIPP: Zeigen Sie auf dem Zielrechner möglichst ein Bild mit senkrechter 
Schraffur oder vielen senkrechten Linien an und optimieren Sie den Phasen-
Wert so, dass die Linien gleichmäßig und scharf dargestellt werden.

TIPP: Haben Sie die Funktion direkt anzeigen (s. Seite 18) aktiviert, können Sie die 
Einstellungen komfortabel ändern und gleichzeitig die Auswirkung im Client-
Fenster betrachten.

HINWEIS: Klicken Sie auf Rückgängig, um die ursprünglichen Werte dieses Rei-
ters wieder zu aktivieren. 
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Tastaturmakros
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Tastaturmakros
Viele Benutzer verwenden Tastaturbefehle zur schnellen und effizienten Bedienung 
des Betriebssystems oder der Anwendungssoftware.

Bei der Bedienung der Zielrechner über den IP-Arbeitsplatz des KVM-Matrixsystems
befinden sich drei Geräte in der Kommunikationsstrecke: der Zielrechner, der 
Matrixswitch und der lokale Computer auf dem der Java Client betrieben wird.

Verwenden Sie die in diesem Kapitel beschriebenen Tastaturmakros des Steuer-
boards, um die Weiterleitung der Tastenkombinationen an den Zielrechner sicher-
zustellen.

Ausführen eines Tastaturmakros
Die Tastaturmakros können wahlweise über das Steuerboard oder mit den – in den 
Einstellungen der Tastaturmakros – gewählten Tastenkombinationen ausgeführt 
werden.

So führen Sie ein Tastaturmakro über das Steuerboard aus:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Doppelklicken Sie auf das auszuführende Makro.

Filterung der Makros anhand einer Gruppe
Um auch bei einer Vielzahl von Makros schnell das gewünschte Makro zu finden, 
können die einzelnen Makros in Gruppen organisiert werden.

So grenzen Sie die auf dem Reiter Makros anzuzeigenden Tastaturmakros ein:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Wählen Sie im Feld Makro-Gruppe die Gruppe aus, deren Makros aufgelistet wer-
den sollen.

WICHTIG: Betätigen Sie eine Tastenkombination (beispielsweise Strg+Alt+Entf), 
wird diese vom lokalen Computer interpretiert und somit nicht zum Zielrechner 
übertragen.

HINWEIS: In der Standardkonfiguration sind die Gruppen Linux, Novell, G&D Hot-
keys, SUN, VMWare, Windows und special keys angelegt.



Videofunktionen
Videofunktionen
Automatische Größenanpassung des Client-Fensters (AutoFit)

Die automatische Größenanpassung passt die Größe des Client-Fensters bei jedem 
Aufschaltvorgang an die aktuelle Auflösung des Zielrechners an.

Ist die Bildschirmauflösung des Zielrechners größer als jene Ihres Computers, so 
können Sie den anzuzeigenden Bildschirmausschnitt im Client-Fenster verschieben 
(s. Seite 6).

So (de)aktivieren Sie die AutoFit-Funktion:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > AutoFit.

Erneute Übertragung des vollständigen Bildschirminhaltes

Mit der Funktion Bild neu zeichnen erreichen Sie eine vollständige Übertragung des 
gesamten Bildschirminhaltes. Eventuell auftretende Bildartefakte werden durch die 
erneute Übertragung beseitigt.

So erreichen Sie die vollständige Übertragung und Darstellung des Bildes:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Bild neu zeichnen.

Erneute Übertragung und Phasen-Erkennung des Bildes

Mit der Funktion Bild neu synchronisieren erreichen Sie eine vollständige Übertragung 
des gesamten Bildschirminhaltes sowie die automatische Phasen-Erkennung.

So erreichen Sie die vollständige Synchronisierung des Bildes:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Bild neu synchronisieren.

TIPP: Für einen optimalen Bedienkomfort ist es empfehlenswert, die Auflösung 
Ihres lokalen Computers höher einzustellen als die des Zielrechners.

HINWEIS: Ist die Funktion aktiviert, erscheint neben dem Menüpunkt eine 
Markierung.

TIPP: Diese Funktion können Sie alternativ mit der F5-Taste aktivieren, wenn das 
Steuerboard aktiv ist.
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Videofunktionen
Automatische Erkennung der Phasenlage

Mit der Funktion Autophase führen Sie eine automatische Erkennung der Phasenlage 
durch. 

So führen Sie die automatische Phasen-Erkennung durch:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Autophase.

Automatische Bestimmung der Farbwerte

Mit der Funktion Auto-Farbeinstellung wird die automatische Bestimmung der Far-
bwerte des Zielrechners ausgeführt.

So führen Sie die automatische Bestimmung der Farbwerte durch:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Auto-Farbeinstellung.

Automatische Erkennung der Bildlage

Mit der Funktion Bildlageerkennung wird die automatische Erkennung der Bildlage 
des Zielrechners ausgeführt.

So führen Sie die Erkennung der Bildlage durch:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Bildlageerkennung.
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Mausbremse
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Mausbremse
Viele Betriebssysteme bieten den Benutzern eine so genannte Mausbeschleunigung an.

Wenn sowohl auf Ihrem lokalen Computer als auch auf dem Zielrechner eine Maus-
beschleunigung durchgeführt wird, hat dies zur Folge, dass sich der Mauszeiger auf 
dem Zielrechner sehr schnell bewegt und hierdurch die Bedienung erschwert.

Mausbremse aktivieren
Die Anwendung der Mausbremse kann während der Sitzung über das Steuerboard einge-
stellt werden.

So (de)aktivieren Sie die Anwendung der Mausbremse innerhalb einer Sitzung:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf System > Mausbremse konfigurieren.

3. Aktivieren oder deaktivieren Sie die Optionen Mausbremse aktivieren bzw. Maus-
bremse global aktivieren im Abschnitt Aktivierung.

4. Klicken Sie auf OK, um die Einstellungen anzuwenden oder verwerfen Sie Ihre 
Eingaben durch Klick auf Abbrechen.

Beschleunigungswert der Mausbremse konfigurieren

So legen Sie den Beschleunigungswert der Mausbremse fest:

1. Schalten Sie sich auf den Zielrechner auf, dessen Beschleunigungswert der Maus-
bremse Sie ändern möchten.

2. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

3. Klicken Sie im Menü auf System > Mausbremse konfigurieren.

4. Stellen Sie den gewünschten Beschleunigungswert über den Regler ein:

5. Klicken Sie auf Speichern, um die Einstellungen zu speichern oder verwerfen Sie 
Ihre Eingaben durch Klick auf Abbrechen.

HINWEIS: Die Mausbeschleunigung der Betriebssysteme wertet neben der Strecke, 
die die Maus verschoben wird, auch die Dauer der Bewegung aus.

Bei „langen“ Bewegungen wird die Bewegung des Mauszeigers auf dem Bild-
schirm beschleunigt.

HINWEIS: Bewegt sich die Maus auf dem Zielrechner zu schnell, verändern Sie 
den Regler nach links (Langsam). Im umgekehrten Fall bewegen Sie den Regler 
nach rechts (Schnell). 



Erweiterte Funktionen
Erweiterte Funktionen

Sitzungseinstellungen
Vor der Herstellung einer Sitzung mit dem KVM-Matrixsystem können Sie die 
nachfolgend beschriebenen Einstellungen der Sitzung festlegen.

Sprache

Die Benutzeroberfläche des Java Clients unterstützt mehrere Sprachen (Deutsch und 
English). Wählen Sie die von Ihnen gewünschte Sprache aus.

Hotkey-Auswahl

Wählen Sie eine Tastenkombination (Standard: Strg+Shift) zum Aufruf des Steuer-
boards.

Bedienung

Bei IP-basierten KVM-Produkten werden die analogen Tastatur-, Video- und Maus-
Signale digitalisiert und anschließend über das IP-Netzwerk übertragen.

Abhängig von der Auflösung und Farbtiefe des Videosignals vom Zielrechner kann 
die zur Verfügung stehende Bandbreite durch ein höheres Datenaufkommen stark 
beansprucht werden.

Um diesen Effekt zu mindern, können Sie im Bereich Bedienung einstellen, wie die 
zur Verfügung stehende Bandbreite bevorzugt verwendet werden soll.

Drei Einstellmöglichkeiten stehen Ihnen zur Verfügung:

HINWEIS: Dies kann zu Performanceeinbußen bei schmalbandigen Verbindungen 
führen. Eine mögliche Auswirkung ist beispielsweise, dass für das Maus-Signal nur 
noch minimale Bandbreite zur Verfügung steht und eine flüssige Bedienung der 
Maus somit erschwert wird.

anzeigen und
bedienen:

Der Bildschirmaufbau und der Mauszeiger werden gleichrangig 
behandelt.

Diese Einstellung wird bei Einsatz einer LAN-Verbindung empfohlen 
(Standardeinstellung).

anzeigen: Der Bildschirmaufbau wird bevorzugt behandelt.

Diese Einstellung wird empfohlen, wenn bei einer schmalbandigen Ver-
bindung die Aufgabe hauptsächlich im „Beobachten“ besteht.

bedienen: Der Mauszeiger wird bevorzugt behandelt.

Diese Einstellung wird empfohlen, wenn bei einer schmalbandigen Ver-
bindung die Aufgabe hauptsächlich in der Administration und Konfigura-
tion der Zielrechner besteht und ein schneller Bildschirmaufbau von 
nachrangiger Bedeutung ist.
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Erweiterte Funktionen
Verschlüsselung

Die Datenübertraugung zwischen dem Matrixsystem und der Software kann durch 
den Einsatz von Verschlüsselungsoptionen gesichert werden.

Während die Übertragung der Authentifizierungsdaten immer gesichert ist, können 
Sie die Daten der Tastatur-/Maus-Aktionen und des übertragenen Videosignals 
optional verschlüsseln.

Folgende Verschlüsselungsoptionen stehen zur Verfügung:

WICHTIG: Werden sensible Daten auf dem Zielrechner angezeigt und editiert, ist 
die Aktivierung der Verschlüsselung des Input- und des Video-Kanals bei Daten-
übertragung über das Internet empfehlenswert.

Wird der Datenverkehr über eine gesicherte VPN-Verbindung geleitet, ist die Ver-
schlüsselung üblicherweise nicht erforderlich.

HINWEIS: Bedenken Sie, dass jede zusätzliche Verschlüsselung Zeit erfordert und 
somit die Performance beeinflusst.

CTRL-Kanal: Über diesen Kanal wird der Datenaustausch im Rahmen des 
Anmeldevorgangs an das Matrixsystem übertragen.

Die Datenübertragung dieses Kanals wird immer verschlüsselt.

Input-Kanal: Über diesen Kanal werden die Tastatur-/Maus-Signale zum 
Matrixsystem übertragen.

Wird auf die Verschlüsselung dieses Kanals verzichtet, ist das 
Abhören (sniffen) der IP-Pakete möglich.

Die Verschlüsselung ist optional und kann geringfügige Performanceverluste 
durch erhöhtes Datenaufkommen hervorrufen.

Video-Kanal: Über diesen Kanal wird das Videosignal des Zielrechners an den 
Java Client übertragen.

Wird auf die Verschlüsselung dieses Kanals verzichtet, kann das 
übertragene Bild des Zielrechners durch abgehörte IP-Pakete 
wiederhergestellt werden.

Die Verschlüsselung ist optional und kann geringfügige Performanceverluste 
durch erhöhtes Datenaufkommen hervorrufen.
G&D UCON-IP-NEO · 27



Erweiterte Funktionen
Bandbreitenmessung
Die zur Verfügung stehende Bandbreite innerhalb eines IP-Netzwerkes kann sich – je 
nach Auslastung des Netzwerkes – ändern. Dies kann zu einem Performanceverlust 
führen.

Falls Sie einen Performanceverlust feststellen, ist die Durchführung einer erneuten 
Bandbreitenmessung empfehlenswert.

So führen Sie eine erneute Bandbreitenmessung durch:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf System > Bandbreitenmessung.

Client-/Serverinformationen anzeigen
Informationen über den Java Client und das Matrixsystem (Server) können Sie über 
das Hilfe-Menü auslesen.

So zeigen Sie die Client-/Serverinformationen an:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Hilfe > Info.

3. Klicken Sie auf Client oder Server, um die entsprechenden Informationen anzu-
zeigen.

4. Klicken auf Schließen.

Systemweite Hotkeys im Client-Fenster
Innerhalb eines aktivierten Client-Fensters stehen Ihnen die folgenden Hotkeys 
während einer Sitzung zur Verfügung.

Strg+Shift+Maustaste Auslösen der Maus aus dem aktiven Client-Fenster

Strg+Shift+Num-Taste In Kombination mit einer Taste des Ziffernblocks der 
Tastatur können Sie innerhalb des Client-Fensters 
scrollen.

Weiterführende Informationen finden Sie im 
Abschnitt Verschieben des Fensterausschnittes (Scrollen) auf 
Seite 13.
28 · G&D UCON-IP-NEO



NOTIZEN



i · G&D UCON-IP-NEO

About this guide

This guide is authored with special diligence and verified by the state of the art for 
correctness.

G&D neither explicitly nor implicitly takes guarantee or responsibility for the qual-
ity, efficiency and marketability of the product when used for a certain purpose that 
differs from the scope of service covered by this guide.

For losses, which directly or indirectly result from the use of the documentation as 
well as for incidental damages or subsequent damages, G&D is liable only in the 
cases of intent or gross negligence.

Warranty exclusion

In the following cases, G&D will not accept warranty claims:

 The devices were not used as intended.
 The devices were repaired or modified by unauthorized personnel.
 The devices offer extensive external damage that was not reported at time of

delivery.
 The devices were damaged by third-party accessories.

G&D will assume no liability for any consequential damages that may arise from 
the use of the products.

Trademark credits

All product and company names mentioned in this guide and other documents you 
have received with your G&D product may be trademarks or trade names of their 
respective owners.

Impressum

© Guntermann & Drunck GmbH 2010. All rights reserved.

Version 1.00 – 14/12/2010
Software: 2.3.001 (00692)

Guntermann & Drunck GmbH 
Obere Leimbach 9 
57074 Siegen

Germany

Phone +49 271 23872-0 
Fax +49 271 23872-120

http://www.gdsys.de 
sales@gdsys.de



Contents
Contents
The Java client .................................................................................................  1
System requirements ..........................................................................................  1
Supported web browsers ....................................................................................  1
Supported operating systems ..............................................................................  1

Getting started ..................................................................................................  2
Starting the Java client .......................................................................................  2
Establishing a connection to the KVM matrix system .........................................  3

Starting a session with the KVM matrix system .............................................  3
The client window .............................................................................................  4

Information in the header .............................................................................  4
Information in the status bar .........................................................................  5
Releasing the mouse from the client window .................................................  6
Scrolling an image section ............................................................................  6

Switching between targets ..................................................................................  7
Accessing a target with the control panel ......................................................  7
Accessing a target via OSD ..........................................................................  7

Switching between target and local computer .....................................................  7
Timeout during inactivity ..................................................................................  8
Using hotkeys during a session ...........................................................................  8
Closing the current session .................................................................................  8
Closing the Java client .......................................................................................  8

Establishing a connection .................................................................................  9
Detecting the average bandwidth .......................................................................  9
Chat function ..................................................................................................  10

Control panel .................................................................................................  11
The user interface ............................................................................................  11

Status display of the connection ..................................................................  11
Menu bar ...................................................................................................  12
Filter function ............................................................................................  12
Accessing the last target (Last Target) ...........................................................  13
Scrolling the image section .........................................................................  13
Information in the status bar .......................................................................  13
Control panel tabs ......................................................................................  13
Options to display the tab entries ................................................................  14
Displaying the on-screen display via the control panel .................................  15

Feasible action in the control panel ..................................................................  15
Closing the control panel ............................................................................  15
Exiting the session .....................................................................................  15
Exiting the Java client ................................................................................  15
Switching to full screen mode of the client window .....................................  16
Defining the position of the status bar .........................................................  16
G&D UCON-IP-NEO · ii



Contents
Video profiles .................................................................................................. 17
Displaying detailed information .................................................................. 17
Changing a video profile ............................................................................. 17

Setting options ................................................................................................. 18
Defining the image width, position and size ................................................ 18
Defining color values .................................................................................. 20
Adjusting the phase position ....................................................................... 21

Keyboard macros ............................................................................................ 22
Executing a keyboard macro ............................................................................. 22
Filtering macros with the help of groups ........................................................... 22

Video functions ............................................................................................... 23
Automatically adjusting the size of the client window (AutoFit) ................... 23
Refreshing the full screen content ................................................................ 23
Resynchronizing the image ......................................................................... 23
Automatically recognizing the phasing ........................................................ 24
Automatically defining the color values ....................................................... 24
Automatically recognizing the image position ............................................. 24

Mouse delay .................................................................................................... 25
Activating the mouse delay ............................................................................... 25
Configuring the acceleration value for the mouse delay ...........................................  25

Advanced functions ......................................................................................... 26
Session settings ................................................................................................ 26

Language ................................................................................................... 26
Hotkey selection ......................................................................................... 26
Operation ................................................................................................... 26
Encryption ................................................................................................. 27

Bandwidth recognition ..................................................................................... 27
Displaying client/server information ................................................................ 28
Systemwide hotkeys in the client window ......................................................... 28
iii · G&D UCON-IP-NEO



The Java client
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The Java client
The Java client provides a virtual console within the IP network. This virtual console 
enables the user to operate and configure the KVM matrix system.

The client is part of the device’s software and immediately ready for use after the 
KVM matrix system has been installed.

System requirements
The web application is carried out in Java Runtime Environment (JRE). 

The start of the web application requires the installation of version 1.5.0 or later.

A free download for Windows, Solaris, Linux and Apple OS is available at
http://java.sun.com/javase/downloads/.

Supported web browsers
The following web browsers support the web application:

 Internet Explorer 7
 Internet Explorer 8
 Mozilla Firefox 3.6

Supported operating systems
The following operating systems have been successfully tested with the Java client:

 Microsoft Windows XP
 Microsoft Windows Vista
 Microsoft Windows 7
 GNU/Linux Ubuntu 10.04
 GNU/Linux Ubuntu 10.10

IMPORTANT: The OpenJDK open source implementation of the Java platform is not
supported.



Getting started
Getting started
This chapter describes the basic operation of the Java client.

Starting the Java client
The Java client can be applied on a computer with installed Java Runtime Environment.

How to start the Java client:

1. Enter the URL https://[device IP address] to the address bar in oreder to call the web 
application.

2. In case the certificate that is stored in the KVM system cannot be verified, you 
are asked to confirm the certificate. The provided certificate contains the follow-
ing features:

3. Click the Start client button above the login box.

NOTE: The following chapters describe all functions and settings in detail.

NOTE: Information regarding the system requirements of the web application can 
be found page 1.

NOTE: If the web application is started via a “simple” http connection, a mes-
sage informs the user that the connection can only be established via a secure 
https connection.

After 10 seconds, the user is automatically forwarded to a secure https connection.

MD5 fingerprint:

A4:53:5C:42:E4:7C:B8:C7:74:1E:40:3F:D7:FE:95:99

SHA1 fingerprint:

E1:59:BF:BC:E3:53:B1:56:0E:23:CE:0E:ED:49:56:CF:98:78:DC:87
2 · G&D UCON-IP-NEO



Getting started
Establishing a connection to the KVM matrix system
After the client has been started, you can start a session with the KVM matrix system. 
The virtual console is now displayed in the Java client.

Starting a session with the KVM matrix system

How to start a session with the KVM matrix system:

1. Use the Authentication paragraph to enter your Username and your Password.

2. Use the Language/Sprache  paragraph to select your language (Deutsch or English) 
(Deutsch oder English).

3. Use the Keyboard Layout/Tastatur Layout paragraph to select the keyboard layout 
(Deutsch, American English, British English, French or Belgian) of your console.

4. Optional: Click on Options, if you want to configure the session settings (see 
page 26 ff.).

5. Start the connection (see page 9) by clicking Login.

IMPORTANT: Ask the administrator of the KVM matrix system if you are not 
familiar with the access data to the system.
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Getting started
The client window
After the Java client has established a connection to the KVM matrix system, the cli-
ent window is displayed on your monitor:

This window displays the on-screen display of the KVM matrix system or the moni-
tor image of the accessing target.

Information in the header

The header of the client window displays the software name and the following infor-
mation:

NOTE: Since the image of the on-screen display is not created by the KVM matrix 
system but by the Java client, its position or the synchronisation settings cannot be 
changed!

Operating status: If the target can be operated in the client window, the square 
brackets display active operation.

Otherwise the square brackets display inactive operation.

Device IP address: The IP address of the KVM matrix system on which the ses-
sion has been started is displayed for your information.

Target name The Target part displays the name of the accessing target.
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Getting started
Information in the status bar

The status bar shows the following information (from left to right):

Status symbol: The symbol indicates if one or several users are accessing the 
target.

Target name: Name of the accessing KVM matrix system target.

Video profile name: Name of the video profile which is assigned to the accessing 
target.

Image frequency: Number of image updates per second that are displayed in 
the client window.

Data transfer rate: Data transfer rate (in kilobyte per second) between KVM 
matrix system and Java client.

»Num Lock« LED The LED is displayed in light green if the Num-Lock function 
is activated on the target.

If this function is disabled, the LED is displayed in dark 
green.

»Caps Lock« LED The LED is displayed in light green if the CapsLock key is 
activated on the target.

If the CapsLock key is not activated, the LED is displayed in 
dark green.

»Scroll Lock« LED The LED is displayed in light green if the Scroll-Lock function 
is activated on the target.

If this function is disabled, the LED is displayed in dark 
green.

NOTE: The status bar can either be displayed above or below the client window 
(see page 16).
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Getting started
Releasing the mouse from the client window

If the on-screen display of either the KVM matrix system or the target can be oper-
ated in the client window, the square brackets display active operation.

The local computer can only be operated via input devices after the mouse has been 
released from the client window.

How to release the mouse from the client window:

 Press and hold the keys Ctrl+Shift while additionally pressing the left mouse key.

Scrolling an image section

If the screen resolution of the target is higher than the resolution on your computer, 
only a section of the target’s screen content can be displayed on your monitor.

Use the scrollbars of the client window or the buttons in the Scroll area of the control 
panel to select the section to be displayed.

How to select the section to be displayed by mouse:

 Click the scrollbars of the client window to select the section to be displayed.
 Click the buttons (see below) in the Scroll area of the control panel.

How to select the section to be displayed by keyboard:

1. Make sure the client window is activated and the »Num  Lock« function is disa-
bled.

2. Press Ctrl+Shift in combination with one of the navigation 
keys (Num key) of the numerical keyblock:

 The keys 8 (up), 6 (right), 2 (down) and 4 (left) move the 
image section in small steps.

 The keys 9 (top right), 3 (bottom right), 1 (bottom down) 
and 7 (top left) put the image section to the respective 
positions.

 The 5 key centres the image section in the middle.

NOTE: In this status, all keyboard entries and mouse activities at the local compu-
ter are directly transmitted to the target.
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Getting started
Switching between targets
You can switch between the targets that are connected to the KVM matrix system 
by using the on-screen display or the control panel.

The following paragraphs provide a detailed description of each mode.

Accessing a target with the control panel

How to access a target with the control panel:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Target tab.

3. If necessary, use the filter function (see page 12), to limit the list of the targets.

4. Use mouse or the arrow keys to select a target.

5. Double-click the target or press Enter.

Accessing a target via OSD

How to access a target using the on-screen display:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the AdonIS.

3. Use the arrow keys to select the target to be accessed.

4. Press Enter.

Switching between target and local computer
If keyboard and/or mouse activities are to be executed on your local computer dur-
ing a session on a target, you do not have to close your session or call the control 
panel.

The paragraph Releasing the mouse from the client window on page 6 provides detailed 
information regarding this topic.

ADVICE: Click the Last Target button (see page 13) to access the last active target.
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Getting started
Timeout during inactivity
If no keyboard or mouse activities are carried out during a time span of 10 minutes 
(default), the active session is about to be cancelled.

An window informs you that the active session is about to be cancelled and offers 
the following possibilities:

 Exit session: Click this button to close the current session immediately.
 Continue: Click this button to continue with the current session.

Using hotkeys during a session
During your session, the following hotkeys are provided to be used in the active client 
window.

Closing the current session
There are two possibilities to close the current session: You can use the control 
panel to close the session or simply close the client window.

How to close the current session:

 If the control panel is open, click the menu Action > Exit session.
 You can also close the client window by clicking the window’s Close symbol.

Closing the Java client

How to close the Java client at your computer:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Action > Exit application.

ADVICE: Use the Config Panel web application to change the timeout settings. This 
particular setting can be found on the KVM Server tab in the configuration settings 
of the matrix switch.

Ctrl+Shift+Mouse key releases the mouse from the active client window

Ctrl+Shift+Num key Use this key combination in combination with the key-
board’s numeric pad to navigate in the client window.
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Establishing a connection
Establishing a connection
When establishing a connection, a window opens on your screen. This window 
informs you about the current status of the connection establishment:

This window displays the following information (from top to bottom):

 Progress bar: Here, you can see the current progress of the login procedure. The cur-
rently executed activity is displayed above the bar.

 Channel encryption: The different channels and the applied encryptions (see page 27) 
are displayed.

Detecting the average bandwidth
The bandwidth is detected while the connection is being established.

Now, the detected value is being applied to edit and transmit the video information.

ADVICE: Click on Advanced while the bandwidth is being detected to display the cur-
rently detected bandwidth in the form of a curve.

NOTE: The provided bandwidth within an IP network can vary depending on the 
network load. This might lead to performance losses.

If necessary, re-execute the bandwidth recognition during the session (see 
page 27) if you notice performance losses.
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Establishing a connection
Chat function
The Java client can be installed on several computers in the IP network.

The client’s chat function enables the user who logs in to the system to contact an 
already logged-in user.

Both users can use the chat to agree on the further procedure.

How to use the chat to agree on the further procedure if the console is already 
occupied:

1. Establish a connection (see page 3).

2. Click Yes to open the chat window.

3. The chat window is displayed on your screen and on the screen of the other user.

4. Enter your message in the input field and click Send or press Enter to send your 
message to the other user.

5. The other user’s message is displayed in the text field in the upper section of the 
window. You can answer this message as described in step 4.

The chat is closed if the other user denies or accepts your request or if you cancel the 
login procedure by clicking Exit session.

NOTE: Only one user can access the IP console at the same time.

NOTE: Your screen now displays a window which informs you that the IP con-
sole is currently occupied and offers to contact the other user.

IMPORTANT: If no button is clicked within 10 seconds, the connection estab-
lishment is cancelled.

NOTE: If the connection cannot be established because the progcess was can-
celled by clicking No, the login mask is displayed again.

NOTE: If the other user does not answer within 45 seconds or clicks on Deny or Exit 
session, his session is automatically being cancelled and your session is being 
established.
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Control panel
Control panel

The control panel is the operating centre of the Java client. All important functions can 
be accessed via the control panel:

 switching between the available targets
 calling the on-screen display of the KVM matrix system
 executing keyboard macros
 scrolling the visible screen contents in the software’s client window
 selecting the image sections to be displayed

The user interface
The user interface provides you with the status displays and tools listed in the fol-
lowing paragraph.

Status display of the connection

The Link Status field displays the current status of the serial connection 
between the Java client and the KVM matrix system.

NOTE: The connection transmits the information and switching states to be dis-
played on the on-screen display to the client.
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Control panel
Menu bar

The menu bar displays the  commands that are currently available (Action, Target or 
Macros, Video, System, View, Help).

Filter function

The filter function above the list of the target enables you to limit the displayed targets.

How to limit the list of displayed targets by using the filter function:

1. Enter any string to the text field.

2. The Target tab only displays the computers that contain the entered string in the 
Target, Physical address or Comment column.

3. Click Delete to discard the filtering.

The connection has been properly established.

The connection is interrupted.

NOTE: Depending on the activated tab of the control panel, either the Target or 
Macro menu item is displayed.
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Control panel
Accessing the last target (Last Target)

The Last Target function enables you to access the last active target from the cur-
rently active target.

How to access the last active target:

1. Click the Last Target symbol next to the filter field.

Scrolling the image section

If the screen resolution of the target is higher than the resolution on your computer, 
only a section of the target’s screen content can be displayed on your monitor.

You can use the buttons in the Scroll area of the control panel to select the section to 
be displayed. Further information regarding this topic are provided in the paragraph 
Scrolling an image section on page 6.

Information in the status bar

The status bar provides the following information (from left to right):

Control panel tabs

The tabs in the middle of the window take the biggest part of the control panel. Here, 
you can display the Targets or Macros tabs:

 The Target tab contains a list of the connected targets.
For each target, the following information is displayed:

NOTE: If you accessed no target since the start of the Java client or you only worked 
on the currently accessing target, this function is not provided.

Video profile name: Name of the video profile which is assigned to the accessing 
target

Image frequency: Number of image updates per second that are displayed in 
the client window

Data transfer rate: Data transfer rate (in kilobyte per second) between KVM 
matrix system and the Java client.

Target: target name in the KVM matrix system

Phys. Addr.: the target’s physical address

Status: the target’s switching status (on or off)

Access: access right for the target

Comment: user comment regarding the target
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Control panel
The symbols that are put in front of the target names have the following meaning:

 The Macros tab enables you to execute keyboard macros (see page 22).

Options to display the tab entries

The lists of Targets and Macros can be displayed in the following display modes:

 List: displays small symbols and the name (next to each other)
 Details: displays small symbols, the name as well as other information in the form 

of a table

How to change the display modes to display the Targets or Macros:

1. Open the control panel of the Java client.

2. Open the View menu.

3. Select the List or Details menu item.

You are accessing this target.

Another user is accessing this target.

Several users are accessing the target.

The target is switched on (green spot).

The target is switched off (red spot).

ADVICE: The keyboard macros to be displayed can be filtered by selecting a 
group (see page 22).
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Control panel
Displaying the on-screen display via the control panel

The on-screen display (OSD) of the KVM matrix system can be dis-
played in the client window. The OSD enables you to operate and 
configure the system.

How to display the on-screen display of the KVM matrix system in the client win-
dow:

1. Click the AdonIS button.

Feasible action in the control panel

Closing the control panel

Close the control panel to continue your work in the software’s client window.

How to close the control panel:

1. Use the menu bar to click on Action > Close control panel.

Exiting the session

Exit the session at the KVM matrix system after you have finished your work or to 
enable another user to use the IP console.

How to exit the session:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Action > Exit session.

Exiting the Java client

How to exit the application at your computer:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Action > Exit session.

NOTE: Since the display of the on-screen display is not created by the KVM matrix 
system but by the Java client, the position and the synchronisation settings cannot 
be changed!

ADVICE: While working in the client window of a target, the OSD of the KVM 
matrix system can be called by pressing Ctrl+Num (default).
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Control panel
Switching to full screen mode of the client window

If the target provides the same display resolution as your local computer, we recom-
mend to display the client window in full screen mode.

In this mode, the client window is enlarged to full screen size so that the full screen 
is available for the image of the target.

How to switch the client window to full screen mode:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Full screen or press F11.

Defining the position of the status bar

The client window’s status bar can either be displayed at the window’s top (default) 
or bottom.

How to define the position of the client window’s status bar:

1. Open the control panel of the software.

2. Use the menu bar to click on View > Status bar > Upper edge or View > Status bar > 
Lower edge.

NOTE: Task bars and other operating elements on your desktop are covered by the 
full screen of the client window.

It is not necessary to scroll in the client window when the full screen mode is acti-
vated.
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Video profiles
When a target is accessed for the first time, a video profile is created and stored for 
this computer.

Each video profile has an individual name. The basic structure of the names created by 
the software and edited by the user has the following syntax:

 [pixels_horizontal]×[pixels_vertical]@[repetition rate_vertical]

Displaying detailed information

How to call the settings of the current video profile:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Edit active profile.

Changing a video profile

All data of a video profile can be edited and adjusted  (image position, phase shift and 
color values).

How to change the settings of the current video profile:

1. Open the control panel using the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Edit active profile.

3. Change the setting(s) of the video profile (see page 18 f.).

4. Click Save to save your settings or discard your changes by clicking Cancel.

NOTE: The Auto- string is put in front of video profiles that were created after the tar-
get was accessed for the first time and whose color values were not detected.

The EIM- string is put in front of video profiles that were created during the initial 
start-up procedure  of the Java client software or with the Create video profile function.
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Video profiles
Setting options
The user is enabled to edit the profile’s video settings. The following pages describe 
the  settings that are provided on the different tabs of the window.

The lower window section is identical on all tabs:

The left corner displays the number of image updates per second in the client win-
dow (image frequency) as well as the data transfer rate (in kilobyte per second) 
between KVM matrix system and Java client.

The following operating elements can also be found in this section:

Defining the image width, position and size

The Image tab enables you to define the image width, the position and the size.

display directly: changes in the settings are immediately applied to the image 
screen in the client window

Test: applies changes in the settings for the display screen in the client 
window

Refresh: synchronizes the transmitted image of the target

Cancel: cancels changes in the settings and close window

Close: temporarily saves settings until the target is accessed again

Save: save settings

Undo: undo all changes since last saving

ADVICE: If you want this tab’s settings to be automatically determined, click on 
Image position recognition.

The following requirements are necessary to execute this function reliably:

 The screen resolution of the target is lower than the resolution of the client window.
 The setting of the frames of the currently accessing target computer lie within a  

gegnerated size (depending on the image resolution).
18 · G&D UCON-IP-NEO



Video profiles
The following settings can be individually optimised:

How to change the preset values:

1. Change your values in the different input fields.

It is recommended not to enter the numeric values directly at the keyboard but to 
use the arrow keys.

Image width: image width (incl. back porch) in pixel

The image width is always bigger than the width of the actually visible 
image section!

Vertical
image position:

pixel (vertical) from which the image starts from

Vertical
image size:

height of the visible image section

When adjusting the image height you can orient yourself to the usual 
image resolutions (e. g. 1024 × 768).

Adjust the image height in way that no black frame remains and the image 
is fully visible.

Horizontal
image position:

pixel (horizontal) from which the image starts from

Horizontal
image size:

width of the visible image section

When adjusting the image width you can orient yourself to the usual 
image resolutions (e. g. 1024 × 768).

Adjust the image position in way that no black frame remains at the left 
side and the image is fully visible.

ADVICE: If the display directly function (see page 18) is activated, you can change 
the settings and, at the same time, view the result in the client window.

NOTE: Click Undo to activate the default values of this tab.
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Defining color values

The Colors tab enables you to individually adjust the color values and the brightness 
of the image.

The following settings can be optimised:

How to change the preset values:

1. Use the slider to adjust the color values and the brightness.

It is also possible to enter the values directly to the particular input fields.

ADVICE: If you want this tab’s settings to be automatically determined, click on 
Image position recognition.

Red: sets the color values for the color red

Green: sets the color values for the color green

Blue: sets the color values for the color blue

Synchronize
color settings:

Activate this option if you want to adjust the contrast. When the 
color value is changed, the other two colors are adjusted as well.

If this function is deactivated (default), you can change the 
weight of the single colors, for example to correct a color fault 
in the image.

Brightness: adjusts the basic brightness of the image

ADVICE: If the display directly function (see page 18) is activated, you can change 
the settings and, at the same time, view the result in the client window.

NOTE: Click Undo to activate the default values of this tab.
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Video profiles
Adjusting the phase position

The setting of the phase position is an important setting to properly process the 
video signal.

How to change the preset phase setting:

1. Select the manually option in the Settings paragraph.

2. Adjust the value according to your needs.

It is recommended not to enter the numeric values directly at the keyboard but to 
use the arrow keys.

3. Optional: If desired, activate the Noise suppression option.

ADVICE: The Auto phase function automatically executes the phase setting.

To properly perform this function, a static image (for example of the desktop) has 
to be output by the target.

This function cannot be performed if the screensaver is activated on the target!

ADVICE: If possible, display a vertically hatched image or an image with many 
vertical lines at the target. Now, optimise the phase value to that effect that the 
lines are evenly and sharply displayed.

ADVICE: If the display directly function (see page 18) is activated, you can change 
the settings and, at the same time, view the result in the client window.

NOTE: Click Undo to activate the default values of this tab.
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Keyboard macros
Many users use shortcuts for a fast and efficient operation of the operating system or 
the application software.

When operating the target via the IP console of the KVM matrix system, three 
devices are arranged in the communication line: the target, the matrix switch and 
the local computer on which the Java client is executed.

Use the keyboard macros of the control panel as described in this chapter to ensure 
that the key combinations are forwarded to the target.

Executing a keyboard macro
The keyboard macros can either be executed via the control panel or via the selected 
key combinations that have been selected in the settings of the keyboard macro.

How to execute a keyboard macro using the control panel:

1. Open the control panel withthe key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Double-click the macro to be executed.

Filtering macros with the help of groups

In order to quickly find a specific macro among the multitude of macros, the macros 
can be grouped.

How to limit the keyboard macros to be displayed on the Macros tab:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Use the Macro group field to select the group whose macros are to be listed.

IMPORTANT: If a key combination, for example Ctrl+Alt+Delete, is pressed, the 
local computer interprets this key combination which is therefore not transmitted 
to the target.

NOTE: The standard configuration provides the groups Linux, Novell, G&D Hotkeys, 
SUN, VMWare, Windows and special keys.



Video functions
Video functions
Automatically adjusting the size of the client window (AutoFit)

During each access, the automatic size adjustment adjusts the size of the client win-
dow to the target’s current resolution.

If the screen resolution of the target is higher than the resolution of your computer, 
you can scroll the image section to be displayed within the client window (see 
page 6).

How to (de)activate the AutoFit function via the Video menu:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > AutoFit.

Refreshing the full screen content

The Refresh image function enables you to transmit the full screen content. Any image 
artefacts that might appear are removed by the retransmission.

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Refresh image.

Resynchronizing the image

The Resynchronize image function enables you to fully transmit the full screen content 
as well as to automatically recognize the phase.

How to fully synchronize the image:

1. Open the control panel withthe key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Resynchronize image.

ADVICE: We recommend to set the resolution of your local computer higher than 
the target’s resolution.

NOTE: A marker next to the menu item indicates if this function is activated.

ADVICE: This function can also activated by pressing F5 if the control panel is active.
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Automatically recognizing the phasing

The Auto phase function automatically recognizes the phasing. 

How to execute the automatic phase recognition:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Auto phase.

Automatically defining the color values

The Auto color adjustment function enables the automatic definition of the target’s 
color values.

How to automatically define the color values:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Auto color adjustment.

Automatically recognizing the image position

The Recognize image position enables the automatic recognition of the target’s image 
position.

How to recognize the image position:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Recognize image position.
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Mouse delay
Many operating systems provide the users with a so-called mouse acceleration.

If the mouse is accelerated on your local computer as well as on the target, the cursor 
moves very fast and complicates the operation.

Activating the mouse delay
The control panel can be used to adjust the mouse delay during a session.

How to (de)activate the application of the mouse delay within a session:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Klicken Sie im Menü auf System > Define mouse delay.

3. (De)activate the Enable mouse delay or Global mouse delay enabled options in the Mouse 
delay settings window.

4. Click Save to apply your settings or discard your changes by clicking Cancel.

Configuring the acceleration value for the mouse delay

How to define the acceleration value for the mouse delay:

1. Access the target for which the acceleration value of the mouse delay is to be 
changed.

2. Open the control panel with the key combination Ctrl+Shift (default).

3. Use the menu bar to click on System > Configure mouse delay.

4. Use the slider to adjust the acceleration value:

5. Click Save to save your settings or discard your changes by clicking Cancel.

NOTE: The mouse acceleration of the operating systems does not only evaluate the 
distance the mouse is being moved but also the duration of this movement.

During “long” movements the cursor movement on the screen is accelerated.

NOTE: If the mouse moves too fast on the target, move the slider to the left 
(Slow). For the opposite, move the slider to the right (Fast). 
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Advanced functions

Session settings
Before establishing a session with the KVM matrix system, the user is enabled to 
define the following settings for their session.

Language

The user interface supports several languages (German and English).
Select your desired language.

Hotkey selection

Select a key combination (default: Ctrl+Shift) to call the control panel.

Operation

At IP-based KVM products, analog keyboard, video and mouse signals are digital-
ised before they are transmitted over the IP network.

Depending on the resolution and color depth of the target’s video signal, the pro-
vided bandwidth can be highly strained due to high data traffic.

To reduce this effect you can use the Operation section to define how the provided 
bandwidth is to be used preferably.

The following three possibilities are provided for adjustment:

NOTE: The performance might be influenced for narrow-band connections. As a 
result, only a minimal bandwidth is provided for the mouse signal which compli-
cates the fluid operation of the mouse.

view and oper-
ate:

The screen layout and the cursor are treated equally.

This setting is recommended if a LAN connection is applied (default).

view: The screen layout is treated preferentially.

This setting is recommended if the task mainly consists of “viewing” when a 
narrow-band connection is applied.

operate: The cursor is treated preferentially.

This setting is recommended if the task mainly consists of administering and 
configuring the target and a fast screen layout is secondary when using a nar-
row-band connection.
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Encryption

The transmitted data between the KVM matrix system and the Java client can be 
secured by applying encryption options.

The transmission of authentication data is always secured. Additionally, you can 
encrypt the data of keyboard and mouse activities and of the transmitted video signal.

The following options for encryption are provided:

Bandwidth recognition
The provided bandwidth within an IP network can vary depending on the network 
load. This might lead to a performance loss.

If you detect losses in the performance, it is recommended to re-execute the band-
width recognition.

How to execute the bandwidth recognition:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on System > Bandwidth recognition.

IMPORTANT: In case sensitive data is being displayed and edited on the target, 
activate the encryption of the Input and the Video channel for transmitting data via 
the internet.

If the data traffic is transmitted via a secure VPN connection, the encryption is not 
required.

NOTE: Please mind that every additional encryption requires time and influences 
the performance.

CTRL channel: This channel transmits the exchanged data for the login proce-
dure at the KVM matrix system.

The data  transmitted on this channel is always encrypted.

Input channel: This channel transmits the keyboard/mouse signals to the KVM 
matrix system.

If this channel is not encrypted, IP packets can be sniffed.

Encryption is optional and can lead to small performance losses due to higher 
data traffic.

Video channel: This channel transmits the target’s video signal to the
Java client.

If this channel is not encrypted, the transmitted image can be 
restored by sniffed IP packets.

Encryption is optional and can lead to small performance losses due to higher 
data traffic.
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Advanced functions
Displaying client/server information
The help menu can be used to read out information on the Java client and the KVM 
matrix system.

How to display client/server information:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click Help > Info.

3. Click Client or Server to display the respective information.

4. Click Close.

Systemwide hotkeys in the client window
The following hotkeys are provided within an active client window:

Ctrl+Shift+Mouse key releases the mouse from the active client window

Ctrl+Shift+Num key In combination with a key of the keyboard’s keypad 
you are enabled to scroll within the client window.

The paragraph Scrolling the image section on page 13 
provides further information regarding this topic.
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